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SMART Board Interactive Whiteboard Hardware Components 
 
When you’ve completed this module, you’ll be able to: 
 

SMART Board™ 
Interactive Whiteboard 
Hardware Components  

Use the buttons and styluses of the SMART Pen Tray 
 
Check the interactive whiteboard status using the Ready Light 
 
Orient the interactive whiteboard 
 
Edit text objects using the SMART Keyboard 
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SMART Board Interactive Whiteboard Hardware Components 
The SMART Board interactive whiteboard is touch sensitive. In projected mode, it operates as part of a 
system that includes a computer and a digital projector. 

With a SMART Board interactive whiteboard you can: 

• touch the surface to control software applications  

• hand write or type directly onto the whiteboard 

• make notes over top of, or input data directly into, a variety of software applications 

• save these changes 

How Does the SMART Board Interactive Whiteboard Work? 
Although a SMART Board interactive whiteboard may also be used in non-projected mode (i.e., without a 
projector), this workbook focuses on using the interactive whiteboard in projected mode. Using a 
whiteboard in projected mode requires three components – a computer, a digital projector and a SMART 
Board interactive whiteboard. These three components work together as follows: 
 

• The computer loads an application and then sends the image to the projector 

• The projector projects the image onto the interactive whiteboard 

• The interactive whiteboard acts as the monitor and input device (mouse and/or keyboard), 
allowing you to control any application by simply touching the whiteboard 

 
 
 
When you touch the whiteboard, you make a connection between two layers of material. This connection 
point is registered by the computer as the location of your cursor and it will be interpreted as a mouse 
click or a mark of electronic ink. It may help you to think of your interactive whiteboard as an input device 
to your computer, just like your mouse or keyboard.  
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SMART Pen Tray 
The Pen Tray consists of: 

• four color-coded spaces for the styluses and one space for the eraser. Each space has an optical 
sensor that identifies when a tool has been lifted from the Pen Tray. 

• two programmable buttons. Press the top Pen Tray button to make the SMART Keyboard appear. 
Press the bottom button to make the next contact with the whiteboard a right-mouse click. 

NOTE: The Pen Tray buttons may be customized through the Control Panel in the SMART Board 
tools. This information is covered in detail later in this workbook. 

 

 

 

 

 

 

 

 

 

 

 
 

Ready Light 
Your SMART Board interactive whiteboard includes a Ready Light that indicates the current state of your 
whiteboard.  

When the Ready Light is It means  

Flashing between red and green the Pen Tray is in the process of powering up 

Steady red the Pen Tray is receiving power 

Steady green the Pen Tray is fully operational  

 

Eraser Black Stylus
Blue Stylus Red Stylus Green Stylus Pen Tray Buttons Ready Light
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Pen Tray Styluses 
To write over top of any computer image that is projected on the interactive whiteboard, pick up one of the 
four styluses from the Pen Tray and write on the whiteboard. 

To write in a different color, place the stylus back in its slot and select another. The color recognition 
comes from the slots in the Pen Tray rather than the styluses themselves. As a result, you must ensure 
that each stylus is returned to its proper slot (the slot with the corresponding color). This feature also 
allows you to write with your finger once a stylus has been removed from the Pen Tray. 

You can also change the default settings for each Pen Tray tool. The styluses can be reconfigured to alter 
the thickness, color or opacity (to create a transparent highlighter effect). The size of the Pen Tray eraser 
can also be changed to suit individual needs, as can the function of the Pen Tray buttons. These changes 
are made through the Control Panel in the SMART Board tools. Control Panel settings are covered in 
detail later in this workbook. 
 
 
Orienting Your SMART Board Interactive Whiteboard 
Since the SMART Board interactive whiteboard is touch sensitive (your finger acts as the mouse), you 
must orient the whiteboard to give the computer an accurate reference source for determining where 
projected objects are located on the surface. As an example, after the orientation procedure, the 
computer will know the exact location of the Windows® Start button as you see it on the screen, thereby 
ensuring an appropriate response when you press it with your finger. You should orient your interactive 
whiteboard when setting it up or if it or the projector has been moved since you last used it. 

 
To orient the SMART Board interactive whiteboard: 

1 Press and hold both Pen Tray buttons until the orientation interface appears. 

or 

Double-press the SMART Board icon in the Windows System Tray to access the SMART Board tools 
and press the Orient button. 

2 Beginning at the upper-left corner of the orientation screen, press your finger or stylus squarely on the 
center of each cross in the sequence indicated. 

 
You can begin using your SMART Board interactive whiteboard as soon as you’re done! 
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SMART Keyboard 
You can add to or edit text objects using the SMART Keyboard. 
 
To access the SMART Keyboard: 
 
Press the Keyboard button on the Pen Tray. 

 
 
 
 
or 

Press the Keyboard button in the SMART Board tools. 

 
Press the appropriate keys on the SMART Keyboard to enter or edit text objects.  

 
 
 

Right Mouse 
Press the Right Mouse button on the Pen Tray to have the interactive whiteboard recognize your next 
press as a right-mouse click. For instance, the right-mouse menu shown below appears when you press 
the right-mouse button and then press on a text object in SMART Notebook™ software.

Press here to open the 
SMART Keyboard 

Right 
Mouse 

Keyboard 
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Quiz: SMART Board Interactive Whiteboard Hardware Components 

1 Name the three components required to operate a SMART Board interactive whiteboard in 
projected mode.  
NOTE: All content in this workbook relates to using a SMART Board interactive whiteboard in 
projected mode. For information on using the whiteboard in non-projected mode, refer to the 
SMART Board User’s Guide. 

2 What indicates that the interactive whiteboard is receiving power? How do you know when the 
interactive whiteboard is ready to be used? 

3 What is the default setting for the top button on the SMART Pen Tray? 

4 Describe two ways to begin the orientation process. 

5 Describe two ways to access the SMART Keyboard. 

6 How do you “right-click” on the whiteboard? 
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Answers: SMART Board Interactive Whiteboard Hardware Components 

1 You’ll need an interactive whiteboard, a computer and a digital projector to operate in projected 
mode. 

2 A steady red Ready Light indicates that the interactive whiteboard is receiving power. A steady 
green Ready Light indicates that the interactive whiteboard is ready to be used. 

3 The default setting for the top button on the SMART Pen Tray is the SMART Keyboard. 

4 Press and hold the two buttons on the Pen Tray or press the Orient button in the SMART Board 
tools to begin the orientation process. 

5 Press the top button on the Pen Tray or press the Keyboard button in the SMART Board tools to 
access the SMART Keyboard. 

6 Press the Right-Mouse button on the Pen Tray to have your next press on the whiteboard be 
recognized as a right-mouse click.  
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Working with Applications on Your SMART Board Interactive 
Whiteboard 
When you’ve completed this module, you’ll be able to: 

Working with Applications 
on Your 

SMART Board Interactive 
Whiteboard 

 

Access applications from the interactive whiteboard 
 
Create and capture annotations and highlight important information 
using the Floating Tools 
 
Capture your annotations  

Insert your annotations as graphics or text into Microsoft® 
Word or Excel software 
 

Present a PowerPoint slide show on the interactive 
whiteboard 
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Working with Applications on Your SMART Board Interactive 
Whiteboard 
SMART Board interactive whiteboards can be used with any computer application.  
If the application runs on your computer, you can use your whiteboard to work with the  
application. 

Your Finger Is Your Mouse 
A press on the SMART Board interactive whiteboard equals a left-mouse click.  
To ensure that your press has the desired effect, it is important to properly orient  
your whiteboard.  

Accessing Your Applications 
Applications may be accessed in the same way as on a desktop computer. The only difference is that you 
use your finger instead of your mouse to select and open files or applications. To perform a right-mouse 
click, press the Right-Mouse button on the SMART Pen Tray and then press on the desired object. Use 
the SMART Keyboard to enter text. For example, you might use the SMART Keyboard to enter data into 
a spreadsheet. 

Writing and Erasing 
Use the styluses and eraser from the SMART Pen Tray to make notes in electronic ink over top of any 
application. The interactive whiteboard recognizes the last tool removed from the Pen Tray as the tool 
you want to use. For example, if you already have a stylus in your hand when you pick up the eraser, the 
whiteboard will assume you want to erase. 

Accessing the SMART Board Tools 
The SMART Board tools provide quick access to the functions that help you operate the interactive 
whiteboard more effectively. Access the SMART Board tools by double-pressing the SMART Board icon 
in the Microsoft Windows System Tray. If the SMART Board icon does not appear in your System Tray, 
press Start, Programs, SMART Board Software, and select SMART Board Tools. The SMART Board 
tools provide ready access to a variety of tools, including the Floating Tools. 

 

NOTE: More details about the SMART Board tools and their functions will be covered later in this 
workbook. 

 

A press with your 
finger equals a 
left-mouse click 

SMART Board Icon  
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Floating Tools 
The Floating Tools is a portable, customizable palette of tools that, when opened, floats over all 
applications on your interactive whiteboard and allows you to perform a wide variety of operations. 
 
The default Floating Tools palette offers features that you won’t find in your Pen Tray and that you may 
find indispensable, such as a large screen pointer (for presentations), a highlighter, a spotlight and a tool 
for clearing and restoring annotations. 

 

Highlighting Information 
When many people read documents, they often use a highlighter to emphasize important information. 
Similarly, when using applications on a SMART Board interactive whiteboard, you may want to highlight 
specific information for the group. The Floating Tools palette includes a Highlighter that can be used to 
highlight on-screen information.  Of course, you can also use a stylus from the Pen Tray or the Pen tool 
from the Floating Tools to circle or underline important information. 

Spotlight 
The Launch Spotlight tool provides a way of focusing attention on a certain part of the screen. Your 
spotlight can be a circle (as shown), square, frame or star of any size. You can also change the level of 
transparency of the shaded area of the screen. Select the menu button to change the shape of your 
spotlight, set the transparency level or exit the Spotlight view. 

 

 

Press here to exit or modify the 
spotlight view. 

Touch anywhere near the Spotlight 
to move it around.  

Select the blue edge 
to expand, contract or 
rotate the spotlight. 

Pen 
Highlighter Eraser 

Launch Spotlight 
Restore/Clear Annotations 

Use Mouse Cursor 
Screen Pointer 

Right Mouse 
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Capturing Annotations 
When you pick up a stylus to write over top of applications other than Microsoft Word, Excel, or 
PowerPoint® software, the Save/Print toolbar automatically appears. The Save/Print toolbar can be used 
to capture annotations into SMART Notebook software. 

Tool Function 

 
Captures annotations and background into Notebook software 

 Captures a screen area you’ve defined using your finger 

 Sends annotations and background to the default printer 

 

If the Floating Tools are open, the Save/Print toolbar will appear in the bottom row of the Floating Tools 
palette once a stylus is removed from the Pen Tray, or when the Pen tool is selected from the Floating 
Tools. 

   Save/Print Toolbar 
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Inserting Annotations into Word and Excel Files 
When you write on the interactive whiteboard while using Microsoft Word or Excel software, you can 
capture your annotations into SMART Notebook software or insert your notes as a graphic or as text into 
your document or spreadsheet.  

 
NOTE: Supported versions include Microsoft Word 97, 2000, and XP and Excel 97, 2000, and XP. 
 
When you pick up a stylus in Word or Excel software, the Capture/Save toolbar will appear. This looks 
similar to the Save/Print toolbar.  
 
 
 
 
 
 
 
 
 
 
You can use these tools to save annotations into the current document as either an object or typed text.  
 
To save your annotations as a graphic or typed text: 
 
1 Press to position the cursor where you want to insert the text or object in the document or 

spreadsheet. 

2 Pick up a Pen Tray stylus. If it isn’t already open, the Capture/Save toolbar will appear. 

or 

Select a writing tool from the Floating Tools palette. In this case, the Capture/Save toolbar will appear 
as the bottom row of the Floating Tools palette. 

3 Press the  button to convert your handwriting to typed text and insert it into the document or 
spreadsheet. 

or 

Press the  button to insert your handwritten note or drawing as an object into the document or 
spreadsheet. Each pen stroke will be inserted as a separate object. You can then use the Drawing 
toolbar to group, arrange and otherwise manipulate these objects. 

NOTE: In Microsoft Word software, annotations can only be inserted in page layout view. If you’re not 
already in page layout view, a message will appear asking if you’d like to switch to that view. Click the 
Yes button.  

Your annotations will become part of the document or spreadsheet and will be saved with the file. 

 

Save Annotations 

Save Annotations as Text 

Capture the Screen 

Capture an Area 
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Inserting Annotations as Text into Other Applications 
When you pick up a stylus and write over most applications, you can insert your handwritten text into the 
underlying application as typed text. 
 
1 Make an annotation. Do not return the stylus to the Pen Tray. 

2 Press on the annotation you want to inset into the application and hold for approximately three 
seconds. A drop-down menu will appear, allowing you to insert the text equivalent of your annotation 
at the cursor-insertion point in the application.  

 
NOTE: “Your Text” always represents your annotation. So if you write “Apple,” and press on the 
whiteboard for three seconds, the menu will show Inject “Apple” Here. 

3 Select Inject “Your Text” Here. 
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Presenting with PowerPoint Software on a SMART Board Interactive 
Whiteboard 
In this module, you’ll explore the topic of presenting on a SMART Board interactive whiteboard. You’ll 
learn how to navigate a PowerPoint slide show as well as how to use styluses and the Floating Tools to 
make notes on PowerPoint slides. You’ll also learn how to save or print annotations with the underlying 
slide. 

PowerPoint Software on a SMART Board Interactive Whiteboard 
The SMART Board interactive whiteboard has several tools for navigating and emphasizing information 
when using PowerPoint. Use a stylus from the SMART Pen Tray, or one of the Floating Tools, to 
annotate or emphasize information during your slide show. Once you’ve finished, you can advance to the 
next slide and the annotations you made will disappear. Or, you have the option of saving your slide with 
the annotations, either in PowerPoint or in Notebook software. 

SMART Shortcuts for PowerPoint Software Users 
When you open PowerPoint in Slide Show view on a SMART Board interactive whiteboard, you’ll notice 
that the SMART Shortcuts for PowerPoint Users dialog and the three-button toolbar appear.  
 
As indicated in the SMART Shortcuts for PowerPoint Users dialog, the default  
setting for slide navigation is the Double Press. This enables you to move forward  
through a slide show by pressing twice on the whiteboard, making the second  
press to the right of the first. To reverse through the slide show, simply make the  
second press to the left of the first. 
 
 
 
 
 
 
 
 
 
 
You can also use the Slide Show toolbar to move through your slide show. The two arrow buttons allow 
you to navigate forward and backward through the presentation. The middle button provides access to a 
menu of commands, including options to save annotations, access the PowerPoint menu or end the slide 
show.  
 
 
 
 
 
 
 
 
 

Use your finger to 
navigate between 
PowerPoint slides  

Menu of Commands 

Previous 
Page 

Next Page 

The Slide Show toolbar automatically appears 
when you run a PowerPoint slide show 



 

Learner Workbook – SMART Board Interactive Whiteboard Training Package 

 
17 

Saving Annotations Made in PowerPoint Software 
SMART Board interactive whiteboard users have two options when saving annotations made over 
PowerPoint slides. You can: 

• save the annotations and the PowerPoint slide to a Notebook file 

• save the annotations into your PowerPoint file 

The standard way to save notes is in Notebook software. When notes are saved in Notebook software, 
they can be converted to text, moved and fully edited.  

When notes are saved directly into a PowerPoint file, they become objects that can be moved, cut or 
pasted. Save your notes directly into PowerPoint if you want them to appear as part of the slide show. 
When you close the PowerPoint file after the presentation is over, you’ll be prompted to save the file.  

 
 
To capture your annotations and the slide background in SMART Notebook software, select Capture to 
Notebook. To save your annotations into the PowerPoint file, select Save Annotations to PowerPoint. 
 
PowerPoint-specific commands have been grouped in a submenu under PowerPoint Commands (see 
below).  
 

 
 
 
Select Go to Slide to quickly navigate to various slides in your presentation. When you select 
Black/Unblack Screen, the SMART Board interactive whiteboard is blacked out and the presentation is 
paused. Select this option again or double-click to resume the slide show. Select Print Slide to print the 
current slide with your annotations to a connected printer. 
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Select SMART Floating Tools to open the floating tools. 

 
You will also notice a Settings submenu with the following options: 
 

 
 
Select Double-Press to Advance to navigate between slides by double-pressing on the interactive 
whiteboard. Deselect to navigate by pressing once on the whiteboard. 
 
Select Show SMART Shortcuts at Start of Show to see the following dialog box whenever you start a 
presentation: 
 

 
 
Select Auto-Save Annotations on Slide Advance to automatically save annotations into the PowerPoint 
file whenever you navigate to a different slide. 
 
Select Transparent Toolbar to make the Slide Show toolbar transparent so that annotations can be seen 
under the toolbar. 
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Capturing Annotations Summary Chart 

Tool Function Applications 

  Word Excel Power 
Point 

Other 

 
Captures annotations and background into 
Notebook software 

ü ü û ü 

 
Captures a screen area you’ve defined using 
your finger to Notebook software 

ü ü û ü 

 
Sends annotations and background to the 
default printer 

û û û ü 

 Converts annotations into typed text and 
inserts it into the document or spreadsheet 

ü ü û û 

 Inserts annotations as an object into the 
document or spreadsheet 

ü ü û û 

 

Accesses a menu to capture annotations to 
Notebook software, or save annotations into 
the PowerPoint slide show 

û û ü û 

 

Captures annotations and PowerPoint slide 
background to Notebook software 

û û ü û 

 

Captures annotations into the PowerPoint 
slide show 

û û ü û 
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Quiz: Working with Applications on Your SMART Board Interactive Whiteboard 

1 Describe two ways to open your Web browser or any other Windows-based application using a 
SMART Board interactive whiteboard. 

2 Which of the Floating Tools is most valuable when highlighting information? Why? 

3 Describe the function of each of the buttons of the Save/Print toolbar. 

4 Describe how to capture your annotations and screen images into Notebook software. 

5 Which button of the Save/Print toolbar must be used in order to allow you to convert your 
handwriting to text? 
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Answers: Working with Applications on Your SMART Board Interactive 
Whiteboard 

1 Open applications on your SMART Board interactive whiteboard in the same way that you open 
applications at your desktop computer. The only difference is that you press the whiteboard 
instead of clicking with your mouse. To open any application, press Start, Programs, and select 
the application you’d like to open or double-press the desktop icon for that application. 

2 Your answers will vary. 

3 The Save/Print toolbar has screen capture, area capture and print buttons. 

4 Press the Camera button in the Save/Print or Capture/Save toolbar to capture the screen (i.e., 
capture the annotations and background into Notebook software). 

NOTE: The Save/Print or Capture/Save toolbar appears automatically when you remove a 
stylus from the Pen Tray or select the Pen, Highlighter, Eraser or Draw Filled Rectangle tool 
from the Floating Tools. 

5 The screen capture (i.e., Camera) button must be used to capture any handwritten electronic ink 
you’d like to convert to text in Notebook software. 
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Using SMART Notebook Software 
When you’ve completed this module, you’ll be able to: 

Use the toolbars and menus in Notebook software to create and 
enhance objects and navigate between the pages in your file 
 
Create, move and change the color of objects within a 
Notebook file 
 
Insert and create templates in Notebook software 
 
Export the contents of a Notebook file in a variety of formats 

Using SMART Notebook 
Software 



 

Learner Workbook – SMART Board Interactive Whiteboard Training Package 

 
24 



 

Learner Workbook – SMART Board Interactive Whiteboard Training Package 

 
25 

Using Notebook Software 
SMART Notebook software is an object-oriented application you can use to create, organize and save 
notes – either on a SMART Board interactive whiteboard or at your desktop computer – and then send 
those notes to a printer. 

Notebook Page in Whiteboard View 
Each Notebook file contains blank whiteboard pages that can be filled with objects. Handwritten notes, 
typed text, graphics and clip art are all examples of objects that can be added to your Notebook file. One 
of the key features of Notebook software is that you can add as many pages as you need to capture the 
required information. Each Notebook page is surrounded by a toolbar, menu items and a Side Sorter – all 
of which help you work with objects in your Notebook file. You can increase the size of a Notebook page 
by clicking on the Grow Page button at the bottom of the page. 

With Notebook software, you can easily move, copy and insert information within the same page or from 
one page to another. Objects can also be grouped, resized, rotated and reformatted, and handwritten 
notes can be converted to typed text. 

 

                  

 
 
 
 
 
 
 
Side Sorter  
The Side Sorter shows a thumbnail image of each page of the current Notebook file. To navigate to any 
page within your file, simply press on its thumbnail image. You can move an object from the active page 
to any other page within your file by dragging it onto any of the thumbnail images. 

 

 

 

 

 

 

 

 

 

 

 

The Side Sorter can be positioned on either side of your Notebook page. You can also drag the inner 
edge of the Side Sorter to view all of the pages within your file. To reorder your Notebook pages, simply 
press and drag any thumbnail to a new location on the Side Sorter.  

Click the Attachments Thumbnail to view attachments. 

Click here to move the Side Sorter to the other 
side of the Window. 

Side Sorter 
Thumbnails 

Active Notebook Page 

Standard Windows 
Toolbars 
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Simple Toolbar (with Big Buttons) 
The Simple Toolbar gives you  access to the basic functions of Notebook software. Select View, Simple 
Toolbar to use the Simple Toolbar. 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

 
 

 

 

 

 
 
 
 
 

Prints the current file or page to the 
computer’s default printer 

Inserts a new blank page immediately after the 
active page 

Enables you to write on the interactive 
whiteboard using your finger 

Saves your file 

Reverses your previous actions 

Moves to the next page of your file 

Allows you to select objects 

Erases in objects  

Moves to the previous page 
of your file 

Opens the Screen Capture tool 

Deletes the selected object(s)  

Deletes the current active page 
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Standard Windows Toolbars 
The Standard Windows Toolbars are the default toolbars for Notebook software. They provide more 
options than those available on the Simple Toolbar, including a zoom feature.  

 
 
Menus 
Notebook menus provide access to many of the same tools and features found on the Simple Toolbar 
and Standard Windows Toolbars, as well as some tools that are not available through either toolbar. For 
example, the Insert Menu allows you to insert a picture from file, or a picture from an attached scanner, 
directly into your Notebook file. 
 

 

Menu Item Access this menu to 

File • open new or existing files 

• export content to a variety of file formats 

• print files or modify print settings 

Edit • undo or redo previous actions 

• cut, copy, paste or delete selected objects or all objects on the 
page  

• add a page title to your Notebook page 

View • change the current view (Whiteboard, Page Sorter, Attachments 
or Full Screen) or toolbars 

• launch screen capture, screen shade or gallery tools 

• use zoom to magnify or reduce your view of page contents  

Insert • add blank page(s), templates, clip art, graphics files or hyperlinks 

Format • change font properties (type, size, bold, italic), color, line width, 
fill, background color or transparency 

Draw • create rectangles, ellipses, lines, shapes and text 

• select, reorder, group or ungroup objects 

• access Pen or Highlighter tools 

Help • access online tutorials or information about Notebook software 
 
Microsoft Windows users will be familiar with most of these menu items. Many are common to Windows-
based applications. You are encouraged to experiment with all aspects of the Notebook software 
interface, including the toolbars and menu items, to familiarize yourself with these functions. 
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Creating and Editing Content with Notebook Software  
Notebook software is an object-oriented software application. This means that you can move and change 
the characteristics of the objects you add to your Notebook file. Notebook software also provides a variety 
of methods for capturing information. It will accept screen and print captures, graphics files and images 
from scanners. 

Handwriting Recognition 
Once you’ve used a stylus from the Pen Tray, or the Pen tool, to add handwritten text to your Notebook 
software application, you have the option of having your handwriting recognized as text. Press the “A” 
icon in the top-right corner of the text object to convert your handwriting to text. Choose the conversion 
alternative you want from those listed and your handwriting will be converted to text. 
 

NOTE: Handwriting recognition only works when using Notebook software on a SMART Board interactive 
whiteboard. 

Changing the Characteristics of Objects in Notebook Software  
Notebook software allows you to change the characteristics of objects you’ve added to your file. To begin, 
press any object on your Notebook page and it will be surrounded by a selection box. 
 
Resizing Objects  
 
Resize an object by selecting the circular grab handle at the bottom right of the selection box, then 
dragging your finger to expand or contract the object.  
 
 

 

Converting your handwriting to text 

Press here to resize the selected object 
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Rotating Objects 
 

Notebook software also allows you to rotate the objects in your file. Rotate an object by selecting the 
Rotation Handle (the green circle at the top of the selection box) and then dragging your finger around to 
the right or left.  

 
Rich Text Editing  
 
Notebook supports rich text editing. For instance, you may want to emphasize the information in your 
Notebook file with different fonts and colors.  
 
 
 
 
Locking the Position of Text Objects 
 

You can create a form within your Notebook file by locking blank text boxes in position. Select Draw, Text 
to create a blank text box with your next press. Use the selection box to drag the blank object to the 
desired width. Right-mouse click on the text box and select Lock Position or select Format, Lock 
Position to anchor that blank text box in place.   

You can lock any text object in place. A gray box surrounds the text object, indicating that it has been 
locked in place. Once locked, text objects may be resized, rotated and edited; however, they may not be 
moved on or between pages until they are unlocked. 
 

 

Press the Rotation Handle and drag and drop to rotate 
the selected object(s) 

Gray box signifies a “lock 
position” text object 
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Importing Images 
You have a number of choices when it comes to adding content to your Notebook file. You can: 

• capture application windows plus your annotations into a Notebook file using the Save/Print toolbar or 
the Capture/Save toolbar, depending on the application with which you are working 

• capture entire screens, windows or screen regions using the Screen Capture tool 

• print entire multi-page Windows files directly into a Notebook file with the Print Capture function 

• use the Insert menu to import an image directly from an attached scanner into a Notebook file 

• use the Insert menu to import graphics or clip art directly into a Notebook file 

• cut or copy either text or graphics to the clipboard and then paste the contents into a Notebook file 

Screen Capture 
The Screen Capture toolbar allows you to capture a picture of a full screen, a window or a portion of a 
screen to a Notebook page. To access the Screen Capture toolbar, press the Capture button on the 
Simple Toolbar or select View, Screen Capture.  

 
 
The default setting will save each screen capture to a new Notebook page. To save your screen 
capture(s) to the current page, de-select the Save Pictures to New Page check box. With this check box 
de-selected, each newly captured image will be “stacked” in the top-left corner of the current Notebook 
page.  
 
NOTE: The Screen Capture toolbar will float over all open applications. 

Tool Function 

 
 
 

Press and drag to outline the area you want to capture. Release pressure once the 
area is selected. 

 
 
 

Press within the window you want to capture. Release pressure once the desired 
window appears as a hatched area. 

 
 
 

Navigate to the screen you want to capture and press on it to make it the active 
screen. Press the Screen button. 

 

Selected by Default 



 

Learner Workbook – SMART Board Interactive Whiteboard Training Package 

 
31 

Print Capture 
Print Capture allows you to add entire multi-page files from other applications to the end of the current 
Notebook file. All pages of the imported file can be immediately viewed − one printed page per Notebook 
page.  
 
Notebook software must be open to accept a SMART Notebook Print Capture. To Print Capture a 
document, open the associated application and select File, Print. When the Print dialog appears, select 
SMART Notebook Print Capture from the drop-down menu of available printers. Press OK to begin the 
Print Capture. 
 

Working With the Information in Your Notebook File 
SMART Notebook allows you to customize the information you’ve added to your file. The next section 
discusses some of the features and functions available when working with the information in your 
Notebook file. 

Page Titles 
Each page in your Notebook file is titled with a date and time stamp by default. To rename the page, 
simply click in the title area at the top of the page and type a new title. You can also select Edit, Page 
Title. 

Select SMART 
Notebook Print 
Capture from 
available printers 

Date and time stamp for page title by 
default 

Page title changed to reflect page content 
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Hyperlinks in Notebook Software 
Notebook software supports hyperlinks. You can associate a hyperlink with any object you’ve added to 
you Notebook file. Enter a full Internet address (e.g., http://www.smarttech.com) and an active link will be 
attached to the text object. Press       to launch your Web browser.  
 

You can also associate a link with any other object in your Notebook file. Simply right-mouse click on the 
selected object, select Hyperlink, and type the URL. 

 

Creating and Viewing Attachments 
You can attach files, links to files or links to Internet Web pages to your Notebook file. Select View, 
Attachments or click on the Attachments Thumbnail at the bottom of the Side Sorter to add or edit files or 
hyperlinks attached to your Notebook file.  

Use the buttons on the left side of the Attachments view or select Insert and then choose to insert a copy 
of a file, a file shortcut or a URL. Browse to the file location to insert a file or a shortcut, or enter a URL. 
To open the file or Web site, simply double-click the name of the file.  

 Double-click here to open the file. 

Press to launch your Web browser 

http://www.smarttech.com
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Gallery Collections 
With a Gallery collection, you can quickly develop and deliver a lesson or presentation that is rich in 
graphic detail. The Gallery function of Notebook software organizes page templates and images in 
collections of related materials. Open a collection, and then use its page templates as background 
images and place its images anywhere in your Notebook file. 

For example, a math teacher could use a collection to place images of shapes over a page template that 
looks like graph paper and students could measure the shapes using an image of a transparent protractor 
– all by working with the same collection.  

You can use one of the collections included with Notebook software, modify a collection to suit your 
individual needs or assemble a new one.  

Opening a Gallery Collection 

Press   (default view) or select View, Gallery (Simple Toolbar view) to open the Gallery 
dialog box. ISelect File, Open and browse to the directory in which you have your 
collections. 

Inserting Templates and Images from a Gallery Collection 
To use a Gallery template as your page background, click the Page Templates tab, then 
drag a template thumbnail onto the current page in the Whiteboard view. Click the Images 
tab to see images that may be useful to you on that page. Drag any image onto the current 
page. 
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Creating Templates  
If there are page layouts you use often, you can preserve them by saving them as Templates. You can 
also save a group of page templates along with corresponding images as a Gallery collection. 

To save a Notebook page as a template file: 

1 From the File menu, select Save Page As Template. The Save As dialog will appear.  

2 Select the folder in which you’d like to save your template file.  

3 Type a name for the template in the File Name field. 

4 Press the Save button. 

Assembling New Gallery Collections 
You can create new collections by importing templates and corresponding images. From the Gallery 
dialog box, select File, New.  Select Edit, Import Image or Edit, Import Template to find an existing 
image or template and import it into the Gallery area. Once you've imported all of the files you want, save 
your collection by selecting File, Save and completing the Save dialog box. 

You can import any collection into an existing collection using the Import Additional Collection feature 
under the Edit menu. You might do this to have related templates and images easily available to you. For 
example, a K-12 math teacher may have a collection of shapes for younger grades, and may wish to add 
those shapes to a geometry collection to teach the formulas for area and parameter to older students. 

You can add any object to the Gallery by dragging and dropping it from your Notebook file. 

 

 

 

Drag and drop to add to the Gallery 
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Presenting Information With Notebook Software 
Notebook software is an effective presentation medium. There are a number of features and 
functions built into the application which are useful to presenters using Notebook software on 
a SMART Board interactive whiteboard. 

Full Screen View 

Full Screen is the optimal view for delivering a presentation. It lets people see your presentation without 
the distraction of toolbars, menus and the Side Sorter. Use the Full Screen toolbar to navigate through 
the contents of a presentation and access menu commands. 

The Full Screen button in the center of the toolbar enables you to access a menu that includes 
commands for ending Full Screen view, accessing drawing tools, opening a Gallery collection and 
formatting objects. 

 
NOTE: If you accidentally close the Full Screen toolbar, you can return to Whiteboard view by pressing 
the Esc key on the keyboard. 

Screen Shade 
Use the screen shade to focus the attention of your audience. With this feature, you can 
insert a pull-down shade over the current page and gradually drag the shade to reveal the 
underlying text and graphics. Select View, Screen Shade to hide information on your 
Notebook page. Use your finger to drag the shade downwards as you reveal your 
information.  
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Sharing Your Notebook File 
Notebook software provides several options for sharing the contents of your file with others. Saving your 
files as Notebook files will ensure that colleagues are able to access content and make and save 
changes. Of course, this requires that Notebook software is installed on the other computers. 

Printing  
To print the contents of your Notebook file, simply press the Print button or select File, Print. You’ll see 
the same Print dialog that appears when you print other documents. Press OK to send your file to the 
default printer. You can choose any of the available printers by pressing the drop-down menu and 
selecting the printer you’d like to use. Set your printing preferences as you normally do and press OK to 
send your print job to the printer. 

Saving Your Notebook File 
The first time you save your Notebook file, you’ll see the Save dialog. Subsequent presses of the Save 
button, or selection of the Save function under the File menu, will save any changes to the same 
Notebook file. 
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Exporting your Notebook File 
You can export your Notebook file in a variety of digital formats. For example, you can export the contents 
of your file as a series of image or HTML files, or as a PDF file. The Export function is useful if you want 
to share information with users outside your organization. Select File, Export and select the file format to 
be used, then press OK. 
 

 
                                       

 
Check this box to automatically export the 
contents of your Notebook file 

Automatically Exporting your Notebook File 
You can automatically export your Notebook file at a specific time interval or whenever you open a 
different page. Select File, Auto Export and complete the dialog, identifying how frequently you want the 
export to occur, your preferred export type and the directory location of the file. 
 
 
 
 
 
 
 
 
 

Choose file format to use for export from the 
drop-down menu 

Choose the frequency of “automatic exports from 
this drop-down menu 
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Quiz: Notebook Software 

1 List two ways to add a text object to a Notebook page. 

2 Describe how to move objects on and between Notebook pages. 

3 Name the toolbars available to Notebook software users. 

4 How do you access the Screen Capture toolbar? 

5 Describe a benefit of using Print Capture to bring information into a Notebook file. 

6 Describe how to save your Notebook file as a PDF file. 
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Answers: Notebook Software 

1 You can add text objects to a Notebook file in several ways. For example, you can add text 
objects using the SMART Keyboard, the keyboard attached to the computer, or by handwriting 
recognition of words written with a stylus from the Pen Tray, the Pen tool in Notebook software or 
some of the Floating Tools. 

2 Drag and drop to move objects on and between Notebook pages. 

3 The Simple Toolbar and the Standard Windows Toolbars are available to Notebook software users. 

4 To access the Screen Capture toolbar, press the Capture button on the Simple Toolbar or select 
View, Screen Capture. 

5 Print Capture allows you to capture an entire file into Notebook software rather than simply what 
appears on one screen. 

6 Select File, Export, PDF to save a Notebook file as a PDF file. 
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Advanced Concepts with SMART Board Tools 
 
When you’ve completed this module, you’ll be able to: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 
 

Advanced Concepts with 
SMART Board Tools 

Access and use the SMART Board tools 
 
Add tools to the Editable Floating Toolbar and create a user profile 
 
Modify the SMART Pen Tray settings and the SMART Board 
interactive whiteboard settings 
 
Create a video with SMART Recorder 
 
Annotate over video with SMART Video Player 
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Advanced Concepts with SMART Board Tools 
The SMART Board tools provide quick access to the functions that help you operate the interactive 
whiteboard more effectively. In this module you’ll explore the SMART Board tools in more detail. You’ll 
learn about advanced options and how to customize and save settings for the SMART Board tools. 

Accessing the SMART Board Tools  
To access the SMART Board tools, double-press the SMART Board icon in the Windows System Tray. 

 

If the SMART Board icon doesn’t appear in the System Tray, press Start, Programs, SMART Board 
Software, and select SMART Board Tools. 

The SMART Board tools will appear. 

 

 

 

 

 

 

 

 

 

 

Tool Function 

Notebook Opens Notebook software 

Recorder Opens SMART Recorder 

Video Player Opens SMART Video Player 

Keyboard Opens the SMART Keyboard 

Floating Tools Opens the Floating Tools 

Control Panel Provides access to settings for the interactive whiteboard, SMART 
Pen Tray, Floating Tools and SMART Aware 

Orient Launches the orientation process  
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Notebook 
Notebook software is an object-oriented application you can use to: 

• record, edit and save information written on a SMART Board interactive whiteboard 

• capture annotations and/or material from other sources  

• import screen- and/or print-captured information  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Notebook software ships with every SMART Board interactive whiteboard. It is a useful tool for capturing 
notes and minutes during a meeting, and for preparing presentations that encourage participation in the 
classroom or the boardroom.  

Side Sorter 
Thumbnail 

Active 
Notebook Page 

Standard 
Windows 
Toolbars 
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SMART Recorder 
SMART Recorder allows you to record everything you do on the SMART Board interactive whiteboard, as 
well as a recording of your voice, as a standard Audio Video Interleave (AVI) file. AVI files can be played 
back using Windows Media Player, which is available free of charge from 
www.windowsmedia.com/download. 

SMART Recorder’s three-button interface is easy to use. The Record, Pause and Stop buttons allow you 
to control the recording process. 
 
 
 
 
 
 
 
 
 
The Options drop-down menu enables you to modify sound, video and file settings from the Recording 
Quality, Video Format and Target Files tabs. Each tab also contains a Restore Defaults button. 

Recording Quality 
You can select a quality setting for both audio and video. For instance, you can record without audio and 
set a custom level (in frames per second) for video quality. 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Press to access sound quality 
settings 

Press to access video 
quality settings 

http://www.windowsmedia.com/download
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Video Format 
Select Microsoft AVI or SMART Recorder AVI as the video format. Both types of video can be played 
back using Windows Media Player. SMART Recorder Video employs an algorithm that results in smaller 
file sizes but can be played back only on computers that have SMART Board software installed. 

 

 
Target Files 
From the Target Files tab, you can define where your videos will be saved. The default directories may be 
changed. This tab also enables you to set low disk space warnings.  
 
 
 
 
 

Press to select the 
video format 

Press to change the Default Save 
Directory or the Temporary Files Directory 

Press to enable low disk space warning 
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SMART Video Player 
SMART Video Player is a convenient tool for viewing and annotating over moving and still video. You can 
use it to play standard video files or the output from video hardware connected to your system. SMART 
Video Player is compatible with video cameras, projectors, scanners and document cameras. 

Opening Video Player 

To open SMART Video Player, double-press the SMART Board icon  in the Windows System Tray and 
press the Video Player button in the SMART Board tools.  
 

 

Playing Video Files 
To open a video file in SMART Video Player, select File, Open. Then browse to the appropriate directory 
and open the file. 
 
Your video will play in the SMART Video Player window. 
 
NOTE: You can also open a file by dragging it from Windows Explorer into the SMART Video Player 
window. 
 
While a video is playing, you can pause it by pressing the Pause button on the Control toolbar. 

 
 
The Pause button toggles to a Play button when the video is paused.  
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If you play your video during a meeting or while making a presentation, you might want to emphasize a 
point or explain a concept in more detail. Just pick up a stylus from the SMART Pen Tray and write on top 
of the video image. You can also press the Pen, Highlighter or Draw Filled Rectangle buttons in the 
Floating Tools to add annotations. 
 
NOTE: If you make many annotations during a short period of time, the width of the annotation lines is 
reduced to prevent excessive demand on the computer’s processor. 
 
If you’d like the video to pause whenever you pick up a stylus or eraser from the Pen Tray (or when you 
select a button in the Floating Tools), do the following: 
 
1 Select Video Player Settings from the Options menu. 

 
2 Select the Pause when Tool(s) Lifted check box. 

3 Press OK. 

 
You can easily remove or restore the annotations you make over a video by pressing the  Clear/Restore 
button. The Clear/Restore button toggles between the Clear and Restore functions. 

You can also save the annotations you make over a video. To do this, press the Capture button. The 
video will pause while the annotations are captured into Notebook software. 
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Fading Out Annotations 
As the video plays, you might want your annotations to disappear without having to press the Clear 
button. If so, use the Fade Out option. When this option is selected, your annotations will gradually fade 
and disappear.  
 
To enable/disable the Fade Out option: 
 
1 From the Options menu, select Video Player Settings. The Video Player Settings dialog will appear. 

2 Select or de-select the Fade Out Annotations check box. 

3 Designate the amount of time (in seconds) that should pass before the ink begins to fade and how 
long it should take to fade. 

4 Press OK. 

Controlling the Screen Size of Your Video 
SMART Video Player includes three views: 100%, 200% and Full Screen. To control the viewing size of 
your video, select a view option from the Options menu. 
 

 
If you select 100% or 200%, the video plays in a window that includes a title bar, menu bar, toolbar and 
status bar. However, the Full Screen view uses the entire whiteboard or screen, so neither the menu nor 
the toolbar are visible. 
 
When you select the Full Screen view, a toolbar appears with buttons for playing and pausing the video, 
as well as for capturing and clearing your annotations. This toolbar also includes a button for returning to 
normal view. 
 

 
NOTE: You can drag this toolbar to any location on your screen. 
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Using Input from Video Hardware 
When you connect a video hardware device (such as a VCR or video camera) to your system, SMART 
Video Player detects the device and adds it to the File menu. Select the hardware device you want from 
this menu, or select File, Select Video Hardware. 
 
NOTE: If you connect a video hardware device to your computer, and it doesn’t appear in the File menu, 
try reconnecting the device. You may also alter the settings so that SMART Video Player automatically 
selects the last video hardware source used. 
 
Select Video Source Settings from the Options menu to configure the video source settings. The Video 
Source Settings Panel dialog contains options for controlling the video format, frame rate and output size 
parameters. 
 
You can control a video playing from a hardware source in much the same way as you would control a 
video from a file. Just press the Play and Pause buttons to start and stop the video, and annotate over the 
video as you would with a video from a file. (You can also capture these annotations by pressing the 
Capture button.) 
 
Keyboard 
The SMART Keyboard enables you to: 

• enter data into any software application 

• type text while at the whiteboard 

• convert handwriting to text 

• edit converted handwriting 

 

 

 

 

 

 

 

  

 

 

 

 

 
NOTE: You can also access the SMART Keyboard by pressing the Keyboard button on the Pen Tray. 

Press here to access 
handwriting recognition 

Use a stylus from the Pen Tray or your finger to enter handwritten text here 

Recognized text will appear in 
these spaces 

Press the Commit button to 
input your data directly into 
the active application 
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Floating Tools 
The Floating Tools offer a portable, customizable palette of tools that floats over all applications on your 
whiteboard and allows you to perform a wide variety of operations.  

The default Floating Tools palette offers features that you won't find in the Pen Tray and that you may find 
indispensable, such as a large screen pointer (for presentations), a highlighter and a spotlight. 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can add to the default Floating Tools palette and save the changed toolbar as a user profile. This 
ensures quick and easy access to the tools you use most often. 

To add tools, press the Control Panel button in the SMART Board tools and select the Floating Tools tab. 
Any or all of the tools listed may be dragged from the List of Tools and dropped onto the Editable Floating 
Toolbar. 

If you save your edited Floating Toolbar as a user profile, your customized toolbar will be available every 
time you use the interactive whiteboard. 

NOTE: Remember to save your customized toolbar as a user profile, or the default Floating Tools will 
appear the next time you press the Floating Tools button. 

Pen 
Highlighter Eraser 

Launch Spotlight 
Restore/Clear Annotations 

Use Mouse Cursor 
Screen Pointer 

Right Mouse 

Default Floating 
Tools 

Tools dragged from the  
List of Tools and dropped 
onto the Editable Floating 
Toolbar 
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Control Panel 
The Control Panel button provides access to the Boards, Pen Tray, Floating Tools and Aware tabs. From 
each of these tabs, you can confirm and modify SMART Board settings. These settings are described 
below. Changes made to the Pen Tray and Floating Tools tabs may be saved as a user profile. 
 
Boards 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Pen Tray – Styluses 
 
 
 

Shows that this whiteboard has 
been successfully connected to 
USB 

Launches the orientation process 

Any issues associated with the 
whiteboard and its connection to 
your computer will appear in this log 

Indicates mode of operation 

Indicates the current status of 
the whiteboard 

Edit connections to serial ports here 

Set the width of the electronic ink 
for each stylus 

Set the color for each stylus 

Select this check box to make the 
selected stylus a highlighter with 
transparent ink 

Shows current stylus settings – color and width 
of electronic ink 

Press here to restore the default 
settings of the selected button 

Select Save As from the drop-down menu to 
save your preferences as a user profile 

Define a width for the eraser or set it to automatically 
size to the interactive whiteboard size  

Select any stylus and change its width, color 
and highlighter settings 
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Pen Tray – Buttons  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Floating Tools  
 
 
 
 
 
 
 
 
 
 

 
  
 

Remove tools by dragging 
them from the Editable 
Floating Toolbar and dropping 
them into the trash bin 

Drag tools from the List of 
Tools and drop them onto 
the Editable Floating 
Toolbar  

Select Save As from the 
drop-down menu to save 
your Editable Floating 
Toolbar as a user profile  

Press here to define Pen Tray button functions 

Press here to access a drop-down menu 
and select the function you’d like to 
ascribe to the Top / Right button. 
Repeat for the Bottom / Left button.  
 

Select Save As from the drop-down 
menu to save your preferences as a 
user profile 

Pen Tray buttons can also be customized for 
whiteboard or non-projected use. Non-projected use 
is not covered in this manual.  
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Aware 
SMART Aware applications are those that work transparently with your SMART Board interactive 
whiteboard. SMART Aware applications allow the user to work with, and input data directly into, the 
application. NOTE: Refer to the SMART Board User’s Guide or online Help for detailed information about 
SMART Aware 
 

 

Selected by default 

Press here to access the  
Aware Preferences dialog 

Press here to see a list of 
active Aware applications 
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Orient 
It is important to ensure that your whiteboard is properly oriented. Orientation ensures that your finger 
press on the surface actually occurs where you intend. This is necessary when you are working with 
applications on the interactive whiteboard. It may help to view the orientation process as “fine-tuning” the 
whiteboard. 
 
Press the Orient button in the SMART Board tools to launch the orientation process. In most cases, this 
4-point orientation will be sufficient. If you feel you require a greater level of precision, press the Control 
Panel button in the SMART Board tools, press the Advanced button, and then select Board Settings. In 
the Edit Advanced Board Settings dialog, select the Pick the Orientation Precision tab to choose the 
Standard (9 Points) or Fine (20 Points) level of precision.  
 

 
 
 
The figure below represents what you’ll see upon choosing the Standard (9 Points) orientation. Press the 
center of each cross to orient the interactive whiteboard. 
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Quiz: Advanced Concepts with SMART Board Tools 

1 Where do you find the SMART Board icon? 

2 How many tools make up the SMART Board tools? 

3 How do you access the Pen Tray and Floating Tools settings? 

4 How do you make changes to the Editable Floating toolbar? 

5 What factors might you consider when deciding whether or not to convert the AVI format files you’ve 
made with SMART Recorder to WMV format? 
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Answers: Advanced Concepts with SMART Board Tools 

1 The SMART Board icon is found in the Windows System Tray. 

2 Seven tools make up the SMART Board tools. 

3 Press the Control Panel button in the SMART Board tools to access the Pen Tray and Floating 
Tools settings. 

4 Press the Control Panel button and select the Floating Tools tab to access the Editable Floating 
toolbar. Drag and drop tools onto the Editable Floating Toolbar, or drag tools to the trash bin to 
remove them. 

5 A desire to reduce the “size on disk” of your video output and to make it available for distribution in 
streaming video format are two reasons you might consider converting SMART Recorder output 
from AVI to WMV format. 
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Additional Resources 
This section will introduce you to: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Additional Resources 

The SMART Training Center 

EdCompass, an online community for educators using SMART 
products 

SMART Ideas® Software 
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Additional Resources 
From additional training materials on the SMART Web site, to an online community for educators, to a 
free version of SMART Ideas® concept-mapping software for use on a SMART Board interactive 
whiteboard, SMART has a number of resources to support your use of SMART products in the classroom. 

The SMART Training Center  
You can access additional training materials from SMART's Web site at 
www.smarttech.com/trainingcenter. Click Download Free Training Materials and select your operating 
system from the links available. You will have access to Quick References and Hands-on Practice 
materials in PDF format. 

Quick References are simple, visual tools that cover features of SMART products on 1-2 
pages. Simply print them out and keep them with you for easy reference. These make great 
handouts for when you share what you've learned with your peers. 

Hands-on Practice exercises provide step-by-step activities, much like what you'll see at the 
back of this workbook, so you can review and practice what you've learned. 

EdCompass Online Community 
EdCompass is an online community for educators using SMART products. It was designed 
for you to: 

• interact with other educators and with SMART 

• access educator-created learning resources 

• exchange ideas and share exemplary teaching practices, and  

• discover new ways of using SMART products to improve learning in your classroom. 

 

We encourage you to visit this site often at edcompass.smarttech.com. 

 

http://www.smarttech.com/trainingcenter
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Viewing and Downloading Lesson Activities 
You can view all of the activities available by clicking Learning Resources at the top of the 
page. Select Lesson Activities at the left of the page, then choose the type of activities 
you'd like to see, such as Notebook or SMART Ideas software activities. You'll be presented 
with a table displaying many activities, and you can sort these by title, subject matter, 
country of origin, and even the student age for which the lesson is appropriate. 

To download a lesson activity: 

1. Select the title of the activity in which you are interested. You'll see a small image and a brief 
description of the activity. 

2. To the right of the image, you'll see a download box. Click XBK or NBK to download the file. You will 
be prompted to open the file or to save it to your computer. 

3. Select Open to launch the software and open the file on your computer. 

or 
4. Select Save to save the file on your computer. You will be prompted to select the location where you 

would like to save the file. 

 
 
  

Click here to download this 
file. 
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SMART Ideas Software 
Whether you refer to it as concept mapping, webbing or graphical organization, the visual 
representation of information is becoming more important as students learn critical thinking 
skills in the classroom. SMART Ideas concept-mapping software not only helps your 
students connect ideas, organize concepts and plan projects – it motivates them to learn.  

Download your Free Version 
You have access to a free version of SMART Ideas software for use on your SMART Board interactive 
whiteboard. From www.smarttech.com, simply select Support, Downloads and scroll down to view the 
SMART Ideas Software section on the page. Choose your preferred operating system. Click the version 
option that says that it is for use on a SMART Board interactive whiteboard.  

Using SMART Ideas Software 
When you open SMART Ideas software, click Open and a new, untitled workspace will appear ready for 
your input. Now, simply start typing or pick up a pen on your SMART Board™ interactive whiteboard. If 
you’ve used your keyboard, you’ll notice that your text will appear inside a text box. Press Enter when 
you've finished typing and you'll see your text appear in a circular symbol. If you’ve used a stylus on the 
interactive whiteboard, you’ll see two symbols above and to the left of your annotation. Select A to convert 
your handwriting into text within a symbol. 

 

You can add meaning to symbols by using different colors and shapes to signify their relationships. For 
example, if you were creating a Fruits and Vegetables diagram, you could make all fruits red and 
pentagonal, and all vegetables green and octagonal, so the viewer can see shared characteristics at a 
glance. 

To show relationships between ideas (symbols), use connectors. A connector is a line in a diagram that 
links two symbols. It can be labeled or unlabeled, thin or thick, solid or dashed, straight, angled or curved, 
as well as any of our other stylized connectors. 
 
When you move a linked symbol, the connector moves with it. However, if relationships between ideas 
change, you can also move connectors independently of their associated symbols.  

 

http://www.smarttech.com
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To connect two symbols: 
 

1. Select any symbol. 

2. Click the Connector button  and drag the cross-hatch cursor to the second symbol. 

3. Release the mouse.  

or 

4. Using your SMART Board interactive whiteboard, simply draw a line between the two symbols. 
 

 

 

The two symbols will be linked by a connector.  
 
 
 

You can create an unlimited number of sub-levels within any symbol to illustrate or expand on 
information. The sub-levels can contain related diagrams. 
 

To create a symbol sub-level: 
 

1. Select a symbol. 

2. Click the inside link (in the bottom-right corner of the selection rectangle).  

or 

3. Select In from the View menu. 

A new workspace will open. 

 

Learn More about SMART Ideas Software 
More detailed information on using SMART Ideas software can be found on the SMART Web site. A 
Quick Reference is also available from the SMART Training Center.  
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Practice Activities 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 

Practice Activities 
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Activity: SMART Board Interactive Whiteboard Hardware Components 
This activity will give you an opportunity to practice orienting your SMART Board interactive whiteboard 
and using the SMART Keyboard. 

Steps 
1 Press and hold both Pen Tray buttons until the orientation interface appears. 
 
 
 
 
2 Orient your interactive whiteboard by pressing firmly on the center of each cross in the sequence 

indicated. 

 

3 Pick up the blue stylus from the Pen Tray and use it to write your name on the whiteboard. 

4 Press the Camera button to save your annotations (i.e., your handwritten name) and the background 
to a Notebook file. 
 

 
NOTE: Notebook software will open automatically, and your annotations and background will be 
saved to a new Notebook page. 

5 Return the stylus to the Pen Tray. 

6 Press anywhere on the desktop to clear your annotations. 

7 Press the Notebook icon in the Windows Task Bar to access Notebook software. 
 

Pen Tray Buttons 

Orientation Interface 
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8 Press on your name to select it. 

 
9 Press the “A” button in the selection box to convert your handwriting to text. 

 

10 Press the Keyboard button on the Pen Tray and use the SMART Keyboard to make any corrections 
to your name or to add your last name. 

 

 
 
 
NOTE: To make changes to text objects, you’ll need to double-press the object to select it and then 
use the SMART Keyboard to make the required changes. 
 
 
 
 
 
 
 

11 Exit Notebook software. There is no need to save your Notebook file. 

Press here to convert your 
handwriting to text 

Keyboard 
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Activity: Working with Applications on Your SMART Board Interactive Whiteboard 
This activity will give you an opportunity to practice using the Floating Tools to highlight information.  
 
NOTE: This activity involves using a Web browser such as Internet Explorer. However, any application 
may be opened in step 1. 

Steps 
1 Open your Web browser. 

2 Double-press the SMART Board icon in the Windows System Tray to maximize the SMART Board 
tools. 

 

 

3 Press the Keyboard button to open the SMART Keyboard. 

NOTE: The SMART Keyboard will open where it was last left. You can move it by dragging it by the 
title bar and dropping it anywhere on your desktop. 
 

 
 

 
 

 

 

 

 

 

 

 

4 Press your Web browser’s Address field and then use the SMART Keyboard to enter your company’s 
Web address or your favorite search engine (e.g., www.google.com) and press Enter. 

 
 

 
 

 
 
 
  
 
 

 

Use the SMART Keyboard to 
enter the address of the Web site 
you’d like to access 

Press Enter when you’ve finished 
typing the Web address 

http://www.google.com
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5 Close the SMART Keyboard. 

 
 
 
 
 
 
 

6 Double-press the SMART Board icon again to maximize the SMART Board tools. 
 
 
 

7 Press the Floating Tools button to open the Floating Tools palette. 

NOTE: The Floating Tools will open in the same position on your desktop as they were when last 
closed. You can move the Floating Tools by dragging them by their grab bar (see below) and 
dropping them anywhere on your desktop.  

 

8 Press the Pen tool to select it. 

 

 

 

9 Use your finger to draw on an area of the Web site. 
 

10 Press the Camera button to save your annotations and background to SMART Notebook software. 

 
 
 
 

NOTE: There is no need to open Notebook software prior to pressing the Camera button. Notebook 
software will launch automatically and your annotations and background will be captured. 

11 Press the Use Mouse Cursor tool in the Floating Tools. 

Use Mouse Cursor Tool 

Spotlight Tool 

Use the grab bar to drag to any  
location on your desktop 
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12 Press anywhere on the interactive whiteboard to clear your annotations. 

13 Exit your Web browser. 

14 Exit the Floating Tools. 

15 Press the SMART Notebook icon in the Windows Task Bar to maximize Notebook software and view 
your annotations and background. 
 
 

16 Exit Notebook software. There is no need to save your file. 
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Activity: Presenting with PowerPoint Software on a SMART Board Interactive 
Whiteboard 
This activity will give you an opportunity to practice using PowerPoint software on your SMART Board 
interactive whiteboard. 

Steps 

1 Double-press the SMART Board icon in the Windows System Tray to maximize the SMART Board 
tools. 

 
 

 

2 Press the Floating Tools button. 

 

3 Press the Right-Mouse button on the SMART Pen Tray. 

4 Press the Start button and select Explore. 

5 Navigate to the location of a PowerPoint file. 

NOTE: You can use any PowerPoint file to complete this activity. 

6 Once you’ve located the PowerPoint file, double-press on its icon to open it. 

7 Select View, Slide Show to begin your PowerPoint slide show. 
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8 Press OK to close the SMART Shortcuts for PowerPoint Users dialog. 
 
 
 
 
 
 
 

9 Use the Double Press navigation method to move forward through the slides of your presentation. 

10 Use the Previous Page button on the Slide Show toolbar to return to the beginning of your 
presentation.  
 
 
 

11 Use either form of navigation – Double Press or the Slide Show toolbar – to navigate to a slide that 
contains information you’d like to highlight. 

12 Use the  tool from the Floating Tools to draw an arrow to, or circle or underline, information you’d 
like to emphasize. 

13 Use the  tool from the Floating Tools to point to another part of the slide. 

14 Double press the Screen Pointer tool to make it disappear. 

15 Press the  tool on the Floating Tools palette. 

16 Press anywhere on the PowerPoint slide to clear your annotations. 

17 Press the middle button on the Slide Show toolbar and select Restore Annotations. 
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18 Press the middle button on the Slide Show toolbar and select Capture to Notebook. 
 

 
NOTE: Notebook software will open automatically. 

19 Press the middle button on the Slide Show toolbar and select End Show. 

20 Close PowerPoint software. 

21 Press the Notebook software icon in the Windows Task Bar to view your annotations and background 
slide. 
 
 

22 Exit Notebook software. There is no need to save your file. 
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Activity: Using Notebook Software 
This activity will give you an opportunity to practice and apply basic Notebook software use skills. 

Steps 
1 Open Notebook software. 

 
 
 
 

2 Use a stylus from the SMART Pen Tray or the Pen tool from the Floating Tools to write a list of 
projects you’ll work on in the next week or month. Include at least three items in your list.  
 

 
 

3 Press on one of the projects you’ve written to select it.  

4 Press the “A” button in the selection box to convert your handwriting to text. Use the SMART 
Keyboard to make any necessary edits to your converted text. 

 
 

5 Repeat steps 3 and 4 for each project you’ve listed. 
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6 Once you’ve converted your handwriting to text, drag and drop the items in your list of projects to 
reorder them to reflect their priority or sequence. 

 
7 Press the Blank Page button to add pages to your Notebook file so that you have one blank page for 

each project.  

8 Press the first thumbnail image in the Side Sorter to select the first page of your Notebook file. 

9 Leaving the first project on the first page, drag the second project to the second thumbnail in the Side 
Sorter, the third to the third thumbnail, and so on. 
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10 On each page, add three tasks associated with each project. 

NOTE: These task items may include the resources needed to complete the task, the names of team 
members or report dates. Ensure that you add at least three items under each project. 

 
 

11 Use a stylus from the SMART Pen Tray to draw an arrow to an item on the active page. 

 
12 Save your Notebook file. 

NOTE: Use a distinctive name for your file so that you can distinguish it from other files on the 
attached computer. For instance, you might include your name and the date in the title to identify your 
Notebook file. 
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Activity: Using Notebook Software – Part II 
This activity will give you an opportunity to practice capturing information and saving it as a series of 
image files. 

NOTE: This activity involves using a Web browser such as Internet Explorer. However, any application 
may be opened in step 4. 

Steps 
1 Open Notebook software. 

 
 
 
 
 

2 Select View, Screen Capture or press the Capture button on the Simple Toolbar. 

 

NOTE: Ensure that the Save Pictures to New Page check box is selected in the Screen Capture 
toolbar. 

3 Minimize Notebook software. 
 
 
 

4 Open your Web browser. 

5 Point your browser to your organization’s Web site. Alternatively, you can point your browser to 
www.smarttech.com. 

Minimize Button 

Screen Capture Toolbar 

http://www.smarttech.com
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6 Press the Area button on the Screen Capture toolbar. 
 
 
 
 
 
 

7 Use your finger to select a screen area to capture. 
 
 
 
 
 

8 Press the Area button once again to capture another area of the screen. 
 
 
 
 
 
 

9 Exit the Screen Capture toolbar.  

10 Exit your Web browser. 

11 Press the Notebook icon in the Windows Task Bar to maximize Notebook software. 
 
 

12 Using a stylus from the SMART Pen Tray, add a title to each page of your Notebook file. 

13 Select File, Export, JPEG. 

14 Press the OK button to accept the default settings, or press the Browse button and specify an 
alternate location. 

 
 

15 Select the “size of images” drop-down menu to choose the size of each image and select 800 x 600 
for a resolution setting. 

 

 
 

Area Button 
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16 Press the OK button. 

17 Browse to the location of the files you’ve just generated (My Documents unless you’ve changed the 
directory) to view your “exported” content. 

18 Exit all applications. There is no need to save your files. 
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Activity: Advanced Concepts with SMART Board Tools 
This activity will give you an opportunity to work with the SMART Board tools. 
 
NOTE: For this activity, ensure that Windows Media Player is installed on your computer. 

Steps 
1 Double-press the SMART Board icon in the Windows System Tray to maximize the SMART Board 

tools. 
 
 

2 Press the Recorder button. 

 

3 Press the Record button. 

 
NOTE: SMART Recorder will automatically include any audio input while recording. If you have a 
microphone connected to your computer, you may wish to include a commentary of the actions you’re 
taking as you work through the steps of this activity. To record without audio, you can choose “No 
Audio” from the Sound Quality drop-down menu in the Recording Quality tab. 

 

4 Minimize SMART Recorder. 
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5 Press the Control Panel button. 
 

 

6 Select the Floating Tools tab. 

 

7 Drag a tool from the List of Tools and drop it onto the Editable Floating Toolbar. 

List of Tools 

Editable Floating Toolbar 
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8     Select Save As from the User Profiles drop-down menu and use the SMART Keyboard to input a 
name for your newly edited toolbar. Press OK. NOTE: If you don’t save the edits to your Editable 
Floating Toolbar, the default Floating Tools palette will appear the next time you press the Floating 
Tools button. 

9     Press OK to close the Control Panel. 

10  Press the Floating Tools button on the SMART Board tools to view your customized Floating Toolbar. 

11   Exit the Floating Tools palette. 

12   Press the Recorder icon in the Windows Task Bar to maximize SMART Recorder. 

. 
13  Press the Stop button. 

14  Input a name and location for your video. 
 

 

 

 
 
 
 

Select Save As from the 
drop-down menu 

Enter a name for your user profile  
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NOTE: Recorder automatically includes a date stamp and video number as the default name for your 
video file. 

15  Recorder will confirm that your video has been successfully saved. 

 

16  Browse to the location of the video you’ve just made and view your video. 
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Session Feedback 
Please take a moment to complete this questionnaire in as much detail as possible. Your feedback is an 
integral part of improving our future training sessions. All comments are welcome. 

1 How many learners participated in the training session? 

o less than 5 
o 5–10 
o 11–15 

2 Please identify your work environment. 

o Corporate 
o Education 
o Government 
o Military 
o Other (specify)   

3 Please rate your level of computer proficiency. 

o Limited 
o Basic 
o Intermediate 
o Advanced 

4 Please describe how you feel you would use the SMART Board interactive whiteboard as a result of 
the training session. Check all that apply and indicate what applications and multimedia you will use. 
E.g. PowerPoint, Internet, Notebook. 

o To present   
o To use applications   
o To record notes   
o To save notes   
o Other   

5    How important are the following interactive whiteboard features to you? 

1 = of no importance, 2 = of little importance, 3 = of some importance, 4 = very important 

Ease of use À Á Â Ã 
Using your finger as a mouse À Á Â Ã 
Using any pen/object as a writing tool À Á Â Ã 
Interacting with computer applications À Á Â Ã 
Writing over top of computer applications À Á Â Ã 
Saving annotations À Á Â Ã 
Editing notes À Á Â Ã 
Distributing notes through a network or printer À Á Â Ã 
Handwriting recognition software À Á Â Ã  
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6    Please indicate the extent to which you agree or disagree with the following statements: 

1 = strongly disagree, 2 = disagree, 3 = agree, 4 = strongly agree 

1    The session was well designed (pacing, adequate time for 
Q & A, etc.) 

À Á Â Ã 

2    I received information from this session that I can use 
immediately in my job. 

À Á Â Ã 

3    The Learner Workbook is an effective learning resource. À Á Â Ã 

4    The activities helped me become familiar with the 
functionality of the SMART Board interactive whiteboard. 

À Á Â Ã 

5     The trainer used good presentation skills. À Á Â Ã 

7 What did you like best about the session? 

  
  
  
  
  
  
  
 
 
8 How would you improve the overall training experience? (Please feel free to comment on the Learner 

Workbook and activities) 

  
  
  
  
  
  
  
  
  
  
  
  
  
  
 
Thank you for taking the time to complete this questionnaire. We appreciate your feedback. Should you 
have any questions or concerns not addressed here, please ask your trainer or e-mail 
services@smarttech.com. 

mailto:services@smarttech.com

